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INTRODUCTION 
 
This introductory level course is aimed at those who want to learn spreadsheet basics 
using Microsoft Excel. 
 
 
Knowledge assumed  

 experience of using a computer, for example keyboard 
and mouse familiarity 

 experience of using Windows, for example familiarity 
with icons, loading software, opening files and saving 
files 

  

 
 
Areas covered  

 worksheet structure 

 formatting cells 

 printing from a spreadsheet 

 using formulae and functions 

relative and absolute references 

 manipulating worksheets 

 simple charts 
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Document signposts 
 
 
 
Instructions for you to type  

 Bold text 
 

 
 
Shortcuts  

 

 
 
Reminders  

  
 
 

 
 
Notes  

  
 
 
 
 
Exercises  
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WHAT IS A FORMULA? 
 
Formulas are what make a spreadsheet so useful. Using formulas lets you calculate 
results from the data stored in the worksheet. 
 
When you create a formula, you use cell references to identify the data to be included 
in the calculation. By using cell references, rather than the values themselves, you 
ensure that any changes to the values in the cells referenced by the formulas 
automatically result in an updated answer. 
 
A formula always commences with an equals sign (=) to indicate that what follows is an 
instruction, not a value. 
 
 

EXAMPLES OF FORMULAS 

 
In the example worksheet below, cells D2 and D3 both contain formulas to add the 
respective cells in columns B and C. 
 
 
 
 
 
 
 
 
 Look at cell D2 

The intention of this formula is to add together the values in cells B2 and C2 (15 plus 
20). If the value in either cell changes, the formula will not take this into account and 
you will need to remember to alter the values in D2, otherwise the resulting figure will 
no longer be correct. This formula, therefore, is not very useful. 
 
 Look at cell D3 

The formula specifies the cell references (B3 and C3) rather than the current values of 
these cells. If you change the values in either or both cells, there is no need to worry 
about the formula in D3. Because the formula uses cell references, the resulting figure 
will be updated automatically. 
 
  

 A B C D 

1  JAN FEB TOTAL 

2 PETROL 15.00 20.00 =15.00+20.00 
3 OIL 5.00 14.50 =B3+C3 
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ARITHMETIC OPERATORS 

 
When creating formulas the following arithmetic operators are used: 
 

Operator Example 

+ (plus sign) Addition (3+3)  

– (minus sign) Subtraction (3–1)  

 Negation (–1) 

* (asterisk) Multiplication (3*3) 

/ (forward slash) Division (3/3) 

% (percent sign) Percent (20%) 

^ (caret) Exponentiation (3^2) 

 
You will now open the workbook JumbleSales.xlsx from the ExcelFormulas folder on 
drive C. 
 
 Open the file JumbleSales.xlsx  
 
ADDITION 
 
 In A20 enter 12 

 In B20 enter 4 

To add these two values together and display the result in C20: 
 
 In C20 type: =A20+B20 

 
 
 Press Enter 

This formula instructs Excel to add the contents of cell A20 to the contents of B20.  C20 
displays the value 16 (12+4=16). 
 
After you have created a formula, any changes to the cells in the formula, automatically 
result in an updated answer. 
 
 In B20 type 10 

 Press Enter 

The value in C20 is automatically updated to 22 (12+10=22). 
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MULTIPLICATION 
 
 In C21 type: =A20*B20 

 Press Enter 

C21 displays the value 120 (12x10=120). 
 
Notice that in Excel an asterisk is used for multiplication. 
 
You can, of course, multiply the contents of a cell by a value. 
 
 In C22 type: =A20*3 

 Press Enter 

C22 displays the value 36 (12x3=36). 
 
 
SUBTRACTION 
 
 In C23 type: =A20-B20 

 Press Enter 

C23 displays the value 2 (12-10=2). 
 
 
DIVISION 
 
 In C24 type: =A20/B20 

 Press Enter 

C24 displays the value 1.2 (12÷10=1.2). 
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CALCULATING THE TOTAL PAY 
 
In cell D3 you are going to enter the formula to calculate the Total for John Markshaw 
(Hourly Rate * Hours Worked). 
 
 Click on cell D3 

 Type = 

The formula is =B3*C3, but instead of typing the cell references you will learn a quick 
way to insert cell references into a formula. 
 
 Point to cell B3 and click the mouse button 

The cell is highlighted and its reference is added to the formula in D3. 
 

 
 
 Type * 

 Point to cell C3 and click 

The cell is highlighted and its reference is added to the formula in D3. 
 

 
 
 Press Enter 

The following result is displayed: 
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COPYING A FORMULA TO ADJACENT CELLS 

 
If you are copying a formula (remember that you usually see the result of the formula 
rather than the formula itself), the cell references change automatically relative to the 
row and column of the cell it is being copied to. 
 
You now need to calculate the Total for the remaining employees. 
 
Rather than create a formula for each one, you can copy the formula entered for John 
Markshaw into the remaining cells in the Total column. 
 
 Click on cell D3 

To copy the formula in D3 to the cells D4:D15: 
 

 Move the mouse pointer over the fill handle (the cursor will change to a thin black +) 

 
 
 Click and hold down the left mouse button and drag the fill handle over the range D4 

to D15 

 Release the mouse button 

Column D now looks like this: 
 

 
 

 Save the workbook. 
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HIERARCHY OF OPERATIONS 
 
As you already know, a formula in Excel always begins with an equals sign (=). Following 
the equals sign are the elements to be calculated which are separated by operators (+, -
, *, / etc).  However, you should be aware that Excel does not always calculate the 
formula from left to right. 
 
Say you entered the following formula into a worksheet: 
 
=2+2*6 
 
You might expect the answer to be 24. 
 
After all, 2 plus 2 equals 4, and 4 multiplied by 6 equals 24. 
 
 
Try this for yourself now 
 
 In cell G3 type =2+2*6 

 Press Enter 

You might be surprised at the resulting answer of 14. 
 
If you combine several operators in a single formula, Excel performs the operations in 
the following order: 
 

first * and /  (Multiplication and division) 

then + and –  (Addition and subtraction) 

 
This is sometimes referred to as BODMAS (Brackets over division, multiplication, 
addition, subtraction) 
 
In the above formula Excel deals with the multiplication first (2 * 6 = 12) and then the 
addition (2 + 12) giving a total of 14. 
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PARENTHESES 

 
To change the order of evaluation (to override the built-in order of precedence between 
*, /, + and -), you use parentheses. 
 
You will enter the same formula again, but this time enclosing the first part in 
parentheses. 
 
 In cell G4 type =(2+2)*6 

 Press Enter 

The answer is 24. 
 
Excel dealt with the calculation in the parentheses first and then multiplied the result. 
 
You can appreciate, therefore, how important it is that you understand how Excel deals 
with the elements in a formula, before you create complex formulas. 
 
 Delete the contents of G3 and G4 
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FUNCTIONS 
 
Functions are predefined formulas that can be used to perform calculations. 
 
The most frequently used functions are: 
 

Name Calculates… 

SUM The total value 

MIN The minimum value 

MAX The maximum value 

AVERAGE The average value 

COUNT The number of cells containing numbers 

COUNTA The number of non-empty cells 

COUNTBLANK The number of blank cells 
 
All of these functions operate on a range of cells. 
 
For example, a range of cells could begin at D2 and end at D16. In this case you would 
express the range as D2:D16 – the colon in this situation can be interpreted as the word 
“to”. So D2:D16 means D2 to D16. 
 

 
 
To total the range of cells above without using a function, your formula would look like 
this: 
 

=D2+D3+D4+D5+D6+D7+D8+D9+D10+D11+D12+D13+D14+D15+D16 
 
However, by using the SUM function the formula is reduced to: 
 

=SUM(D2:D16) 

D2:D16 
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You can enter functions into your worksheet in three different ways: 
 

 using the AutoSum function button on the Ribbon 

 using the Insert Function button 

 typing the function (this is not recommended)  
 
 

AUTOSUM BUTTON 

 
You are required to add up all the figures in the Total column to calculate the 
company’s monthly salary expenditure, and display the value in D17. 
 
 Select the cell in which the total is to appear – in this case D17 

The AutoSum button creates a SUM formula. 
 
The AutoSum button is in the Editing group 
on the Home tab, and also in the Function 
library group on the Formulas tab. 
  
 Click the AutoSum button  

Excel automatically selects a range for you (indicated by a dashed box around the cells). 
 

 
 
You should always check to ensure that the range that is selected is correct – do not 
assume that Excel has got it right! 
 
 If this range is correct (it should cover all of the figures in column D) press Enter 

The result of the calculation is displayed in the selected cell, D17. 
  

AutoSum 
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If the range is not correct then you can either: 
 
 Click into the Formula Bar and type the correct range before pressing Enter 

Or 
 
 Highlight the required range using the mouse pointer and then press Enter 

If a cell in your worksheet displays #########, don’t panic. 

This indicates that the cell is not wide enough to display the result of your calculation. 

To solve the problem simply increase the cell width. 

 
Many functions are used in a similar way. 
 
 Delete the contents of D17 

To calculate the average pay of all the employees: 
 
 With D17 selected, click the down arrow next to the AutoSum button 

 
 
This gives you quick access to some of the most common functions. 
 
 Click Average 

 



Excel 2010 Getting Started (310712) 13 ©De Montfort University, IT Training 2012 
 

 Check to ensure that the range selected is correct (i.e. all the numbers in column D 
are selected) 

 Press Enter 

The average is calculated to be 194.79231 
 
 Click the Undo button on the Quick Access Toolbar to undo the average function 

 
 
Other functions can be accessed via the AutoSum button. 
 
 Click the down arrow next to the AutoSum button 

 Select More Functions 

The Insert Function dialog box is displayed. 
 

 
 
This dialog box can be accessed in various ways and is the general method used for 
inserting most of the functions that are available in Excel. 
 
 Click Cancel 

  

Undo 
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INSERT FUNCTION 

 

Another way to access the Insert Function dialog box is to use the Insert  Function 
button on the Formula Bar. 
 
For this exercise you will use a function in A17 to display the number of employees listed 
on the spreadsheet.  The function needed is called COUNTA. 
 
 In cell A17 type no of staff:  

 Select B17 (this is where the result is to be displayed) 

 Click the  button 

The Insert Function dialog box is displayed. 
 
 The default category is Most Recently Used. If the function you require is not listed 

then it is recommended to use the All category to find your function. 

 Click the down arrow in the Or select a category box and select All. Scroll down the 
list to find the function you want. 

 
 
 Alternatively a quick way to find a function is to use the Search facility. Type 

COUNTA in the search box and select Go. 

 

 

 

 

 

 

 Click once on the function you want and click OK  
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The Function Arguments dialog box is displayed. 
 
 In the Value 1 box type: A3:A15 (this is the range of cells that we want the function 

to count). Alternatively you could have selected the cell range using your mouse. 

 
 
 Click OK 

This function works by counting the number of non-empty cells in the range that you 
specify.  It therefore counts the number of names in A3:A15 and returns the value 13. 
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EXERCISES  

 
 In cell A19, type TOTAL 

 In cell C19 use the SUM function to calculate the total number of Hours Worked by 
all the employees (i.e. sum the range from C3 to C15) 

 Copy this formula to cell D19 to calculate the total pay for all the employees 

 In A20, type AVERAGE 

 In C20, use the AVERAGE function to calculate the average number of hours worked 

 In A22, type Maximum Salary 

 In A23, type Minimum Salary 

 In D22, use the MAX function to calculate the Maximum salary from the Total 
column, ensuring that you specify the correct range 

 In D23 use the MIN function to calculate the Minimum salary from the Total column, 
again ensuring that the range is correct 

 
 
 Save the workbook 
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DISPLAYING FORMULAS 
 
When you select a cell, you can see the formula (if there is one) displayed in the 
Formula Bar. It is also possible to view the formulas used in the entire worksheet. 
 
 Select the Formulas tab 

 Click the Show Formulas button in the Formula Auditing group 

 
 
The formulas used in the worksheet are displayed. 
 

 
 

DISPLAYING VALUES 

 
To return the display to values rather than formulas: 
 
 Click the Show Formulas button to deselect it 

To display/hide formulas 

Press and hold the                    key and press the              key at the top left of the 
keyboard. 
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PERCENTAGES 
 

There are several ways to use percentages in formulas and this section will look at some 
useful calculations that you may use in your spreadsheet. 
 

CALCULATING THE PERCENTAGE DIFFERENCE BETWEEN TWO NUMBERS 

   
It can be useful to know the difference between two numbers as a percentage.  
For example, your earnings are £2,342 in November and £2,500 in December. What is 
the percentage change in your earnings between these two months? To do this task, use 
the subtraction (-) and division (/) operators. 
 
 Open the workbook PayRoll from the ExcelFormulas folder on drive C. 

 Ensure you are on the Previous Payroll worksheet. 

You are going to work out what percentage increase the staff have received in their 
salary within the last year.  

 In cell D3 type the following formula: 

=(C3-B3)/C3 

 Ensure the number in D3 is formatted as a percentage to 2 decimal places and copy 
the formula down to the other staff. 

This formula divides the difference between the second and first numbers, by the first 
number to get the percentage change.  

INCREASE OR DECREASE A VALUE BY A PERCENTAGE 

Another useful calculation is to increase or decrease a value by a specific percentage. 

For example, all salaries need to be increased or decreased by 5%. 

 Still using the workbook PayRoll select the Payroll worksheet. 

You are going to work out the new salary when a 5% bonus is added to their current total 

pay. 

 In cell H3 type the following formula: 

=D3*105% 

Alternatively you could have typed 

=D3+(D3*5%) 

 Copy the formula down to the other staff 

N.B To work out a decrease you would use the following formula:  =D3*95% or D3-(D3*5%) 

 

EXERCISES- PRACTICE SHEET 1  
 

 Complete Practice Sheet 1 – Percentage Calculation 
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RELATIVE AND ABSOLUTE REFERENCES 
 

RELATIVE REFERENCE 

 
By default, formulas in Excel use relative cell references.  This means that, as a formula 
is copied and pasted to other cells, the cell references in the formula change to reflect 
the formula’s new location. The example below shows the effect of copying the formula 
in cell C1 to other cells in column C. 
 

 A B C 

1 6 3 18 (=A1*B1) 

2 4 2 8 (=A2*B2) 

3 10 4 40 (=A3*B3) 

 
However, let’s say that in column C you want to produce a formula that will multiply 
cell A1 by a series of cells in column B. 
 
In other words, you want the following: 
 

 A B C 

1 6 3 18 (=A1*B1) 

2  2 12 (=A1*B2) 

3  4 24 (=A1*B3) 

 
To achieve this, the reference to cell A1 needs to be changed from a relative reference 
to an absolute one before copying the formula down the column. 
 
 

ABSOLUTE REFERENCE 

 
An absolute cell reference in a formula does not change when the formula is copied and 
pasted into other cells. 
 
In the formula above, to make the reference to cell A1 absolute, and therefore ensure 
that it remains unchanged when it is copied to other cells, you include $ signs ($A$1). 
 
The diagram below illustrates what happens when the formula in C1 is changed to 
=$A$1*B1 and then copied down to other cells in column C. 
 
The absolute reference ($A$1) has remained unchanged, and the relative reference (B1) 
has changed to, B2 and B3 respectively. 
 

 A B C 

1 6 3 18 (=$A$1*B1) 

2  2 12  (=$A$1*B2) 

3  4 24 (=$A$1*B3) 
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USING ABSOLUTE REFERENCES 

 
 Select the Payroll worksheet  

 Overtime pay is calculated using the formula: 

 
Hourly rate * Overtime rate * Overtime hours 

 
 In F3, calculate the overtime pay for John Markshaw 

 

To calculate the overtime pay for John Markshaw: 

  Select F3 

  Type =B3*A19*E3 

  Press Enter 

 
You now need to copy this formula down the column to calculate the overtime pay for 
the other employees. 
 
 Select cell F3 

Before copying the formula you must first decide if any of the references need to be 
absolute. 
 
The Hourly rate figure changes for each employee and therefore this needs to be a 
relative reference. 
 
The Overtime hours figure changes for each employee and therefore this also needs to 
be a relative reference. 
 
However, the Overtime rate figure is the same for every employee and this is stored in 
A19.  Therefore A19 must be made into an absolute reference. 
 
 Position the insertion point in the Formula Bar and edit the formula so that the 

reference to cell A19 is made absolute by including $ signs 

A quick way to make a cell reference absolute is to use the F4 key on your keyboard 

 
=B3*$A$19*E3 
 
Remember to press Enter when you have finished editing the formula. 

 
  



Excel 2010 Getting Started (310712) 21 ©De Montfort University, IT Training 2012 
 

 Copy the formula down the column to all employees 

 
 
 Click on the overtime pay for some of the other employees to see that while the 

hourly rate and overtime hours references have copied relatively, the overtime rate 
reference is absolute 

 Save the workbook 

As some staff have worked overtime, this figure must be added to their pay. 
 
 Select cell G3 ready to calculate the Total Pay for John Markshaw 

 Edit the formula to include his Overtime pay 

 
 
 Copy the amended formula down to the other staff – you do not need to make any 

part of this formula absolute 

 To finish this exercise, use the SUM function in cell G17 to total the column 

 
 

 

EXERCISES- PRACTICE SHEET 2  

 
 Complete Practice Sheet 2 – Absolute Cell Referencing 
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CONDITIONAL FORMULA 
 

IF  

 
The IF function is one of the most important functions in Excel as it can give your 
formulas decision-making capabilities. 
 
The IF function includes a logical test, that compares a cell against a specified value.  A 
logical test is a test that produces an answer of either True or False. 
 
The IF function is structured as follows: 
 
=IF(Logical Test, Value 1, Value 2) 
 
Which produces these results: 
 
If the Logical Test is TRUE, Value 1 is inserted into the cell 
If the Logical Test is FALSE, Value 2 is inserted into the cell 
 
If the Value is text rather than a number, it must be enclosed in quotation marks 
(“text”). 
 
For example, you might want to include the words “solvent” or “bankrupt” as the result 
of a calculation in the worksheet. 
 
 

You can compare two values with the following operators. When two values are 
compared using these operators, the result is a logical value, either TRUE or FALSE. 
 
> More than 
< Less than 
= Equal to 
>= More than or equal to 
<= Less than or equal to 
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The management of Jumble Sales Corporation has decided that staff who earn £7.50 or 
less per hour will receive a bonus of £20 and all others will get £10. 
 
Therefore, the bonus depends on each member of staff’s hourly rate.  So the logical test 
must check to see if the hourly rate is £7.50 or less. 
 
 Still using the workbook PayRoll select the Bonuses worksheet 
  
To calculate the bonus payment for John Markshaw: 
 
 Select cell E3 (this is where his bonus pay will be entered) 

 Click the Insert Function button 

 
 
 Select the IF function 

 

If this function is not available in the Most Recently Used list 

  Click the down arrow 

  Select either All or Logical 

 

You should now be able to choose the IF function. 

 
 
 Click OK 
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The Function Arguments dialog box for the IF function is displayed. 
 

 
 
There are three boxes to complete, and the first one is the logical test. 
 
You must test to see if the hourly rate is £7.50 or less.  The hourly rate value is in B3, so 
you are testing to see if B3 is £7.50 or less. 
 
In the Logical_test box, type B3<=7.5 
 
This will check to see if B3 is less than or equal to 7.5.  The pound sign ‘£’ is not 
included because this is just formatting. 
 

The logical test must include 

●  A cell reference 

●  An operator 

●  A value 

 
 In the Value_if_true box, type 20 

This gives a bonus of £20 if the hourly rate is £7.50 or less. 
 
 In the Value_if_false box, type 10 

This gives a bonus of £10 if the hourly rate is more than £7.50. 
 

 
 
 Click OK 
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E3 displays John Markshaw’s bonus as 20. 
 

 
 
 
 Look at the formula in the Formula Bar 

=IF(B3<=7.5,20,10) 
 
 
 
 
 
 
 
 
 
 
 Copy the formula down the column to the other members of staff 

 Look down the Bonus payment column to check that the figures are correct 

 Ensure that the range E3:E15 is formatted as Currency 

 Save the workbook 

  

Logical Test: 
Is the value in cell B3 less than 
or equal to 7.5? 

If the test is 
true return the 
value, 20 
 

If the test is not 
true then return 
the value, 10 
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COUNTIF & COUNTIFS 

 
The standard functions that are used to count cells in a range are COUNT, COUNTA and 
COUNTBLANK. 
 
COUNT(range)  counts the cells in the range that contain numbers 
COUNTA(range)  counts the non empty cells in the range 
COUNTBLANK(range) counts the empty cells in the range 
 
The COUNTIF function enables you to count only the cells that satisfy a specific criteria. 
 
The syntax is: 
 

=COUNTIF(criteria range, criteria) 
 
Where: 
 
criteria range  is a specified range 
criteria is the condition or value that cells in the specified range must 

satisfy in order to be counted 
 
 Open the file ClubMembership. 
 
The next example shows how to count the number of memberships depending on the 
type. 
 
 In C112 use the Insert Function button and locate the COUNTIF function: 

 Ensure your cursor is in the Range box and highlight the range H7 to H108. 

 Place your cursor in the Criteria box and select the cell B112 

This will set the criteria to Gold as that is the content of cell B112 

 Click OK. 

Ensure you have selected cell C112 and look at your formula bar. Your formula should 
look like this:  

=COUNTIF(H7:H108,B112) 
 
The number of Gold memberships is 29. 
 
This formula can now be copied for the other membership types. However, for it to 
work some cells will need to be made absolute. 
 
Can you work it out? 
 
You should have made the range H7:H108 absolute in order for your formula to work 
when copied.  
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COUNTIFS works in the same way but can take multiple pairs of criteria range and 
criteria. 
 
You need to find the number of staff in the Brokerage department with Gold 
memberships: 
 
 In G112 use the Insert Function button to locate the COUNTIFS function. 

 In the Criteria_range1 box highlight the cell range H7:H108 

 In the Criteria1 box insert the text “gold”  (notice that another box has now 
appeared so you can add a second criteria) 

 In the Criteria_range2 box highlight the cell range G7:G108 

 In the Criteria2 box insert the text “brokerage” 

You could keep adding criteria but we have finished for this example 

 Select OK 

The answer is 6. 
 
The above formula counts the number of rows where gold is present in column H AND 
brokerage is present in column G. 
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SUMIF & SUMIFS 

 
The SUMIF function is used to sum data in a selected range when specified conditions are 
met. 
 
The standard SUM function can be used to calculate the total Annual Fee, but if you 
need to calculate the total Annual Fee for the Maintenance department, or the total 
Annual Fee for the Maintenance staff who joined after 1995, then either SUMIF or 
SUMIFS will need to be used. 
 
The syntax for the SUMIF function is: 
 

=SUMIF(criteria range, criteria, sum range) 
 
Where: 
 
criteria range is the range where you want to look for a specific condition 
criteria is the value or condition to look for in the criteria range 
sum range is the range you want to sum once the above criteria has been met 

Sum range and criteria range must have equal length and shape. 

 
SUMIFS allows you to have multiple criteria range and criteria pairs which enables you to 
sum data that satisfies many different criteria. 
 
For the first example you will calculate the total Annual Fee for the Sales department. 
 
 Still using the ClubMembership workbook  

 In G115, use the Insert Function button to locate the SUMIF function 

 In the Range box select cells G7:G108 

 In the Criteria box type “brokerage” 

 In the Sum_range box select cells i7:i108 

The answer is £9,918.00.   Your formula should look like this:  
 

=SUMIF(G7:G108,”brokerage”,I7:I108) 
 
Explanation: 
 
g7:g108 is the criteria range (the range in which to look for the criteria) 
“brokerage” is the criterion to look for in g7:g108 (text must be enclosed within 

double quotes) 
i7:i108 is the sum range (the range of cells to be summed. This can be left blank 
 if it is the same range as the criteria) 
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Next you will calculate the total Annual Fee for members of the Brokerage department 
who joined after 1995. 
 
 In G118, use the Insert Function button to locate the SUMIFS function: 

 In the Sum_range box select cells i7:i108 

 In the Criteria_range1 box select cells G7:G108 

 In the Criteria1 box type “brokerage” 

 In the Criteria_range2 box select cells D7:D108 

 In the Criteria2 box type >31/12/1995 

The answer is £4181.50. Your formula should look like this: 
 

=SUMIFS(i7:i108,g7:g108,“brokerage”,d7:d108,“>31/12/1995”) 
 
Explanation: 
 
i7:i108   the sum range 
g7:g108,“brokerage” first pair of criteria range and criteria 
d7:d108,“>31/12/1995” second pair of criteria range and criteria 
 
The function sums the cells in the sum range for the rows that satisfy both conditions. 
 
 
 Save and close the workbook 

 

EXERCISES- PRACTICE SHEET 3 

 
 Complete Practice Sheet 3 – Conditional Formula 

 


